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Sponsored by the Auburn University Department of Curriculum and
Teaching, The Florida State University Center for Music Research, The
School of Music at the University of Oklahoma, and the Music Educa-
tors National Conference

The National Symposium on Music Instruction Technology was held
July I 3 - 14, 2001 , at the Auburn University Hotel and Conference Center,
Auburn, Alabama. The ongoing theme of the conference was "Practice and
Research." The symposium was a project of the Center for Music Research
at Florida State University, the Music Education Program of Auburn Uni-
versity, and the School of Music at the University of Oklahoma. The sym-
posium was co-sponsored by MENC.

Music educators and music education researchers shared knowledge
and experiences concerning technology enhanced music instruction. The
goals of the symposium were to (a) accelerate the exchange of ideas among
practitioners and researchers, (b) to encourage appropriate uses of music
technology in PreK-12 learning environments, and (c) to disseminate find-
ings of investigations into learning with music technology.

The following pages are summaries of the symposium presentations.
Several presenters also submitted article-length research manuscripts that
were reviewed for potential publicati on in the JTM L Dr. B arry' s full-length
reviewed article is in this issue of JTML. Dr. Price and Dr. Pan's article
appeared in Volume l, Issue 2.

The Fourth National Symposium on Music Instruction Technology was
held June 6-8 2002 at the University of Oklahoma. The Fifth National Sym-
posium on Music Instruction Technology recently was held (June 26-28,
2003\ at Illinois State University, organized by Dr. Kimberly McCord. The
2004 National Symposium will be held in Valley City, North Dakota, Dr.
Sara Hagen, organizer (see announcement at the end of this issue). Informa-
tion for upcoming and past Symposia is available at http ://www. auburn. edu/
music educationA.{ SMIT.
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Music Educator Computer Technology Use in Alabama,
tr'lorida, and Georgia

John Jinright, Troy State University

This presentation described preliminary results of a Music Educator
Computer Technology Use survey that was mailed to a random sample of
1,895 music teachers in Alabama, Georgia, and Florida who were members
of MENC. The survey was part of the presenter's in-progress doctoral dis-
sertation study.

Most of the music teachers reported in 2000 that they would not, or
likely would not use a computer in classroom instruction on an average day.
Only 9o/o of Alabama respondents, l9% of Florida respondents, and 17%o of
Georgia respondents reported that perhaps they would, or probably they
would use a computer in a class on an average day.

The average age of the respondents was 42.5 years and the average
number of years teaching was 14. There was a significant different in edu-
cation level of the respondents , F(2, 549) : 16.57 ,p : .00. Florida music
teachers held fewer advanced degrees than Alabama and Georgia music
teachers.

Significant differences were not found between states in the number of
schools in which the music teacher teaches, the number of students taught in
an average day, nor the number ofclasses taught per day. However, there
was a significant difference in the class size, F(2, 547) : 8,63, p: .00.
Alabama mean class size of 53 was greater than Florida's class size of 46
and Georgia's average class size of42.

When asked about computer ownership,S9Yo of the teachers responded
that they have a computer at home, 92Yohave a computer to use at work, and
57%ohave a computer at work that is accessible for student use. Over half of
the teachers in each state reported that they use a computer at home I to 5

hours per week.
Fifty percent or more ofteachers reported that they had access to the

following types of software and hardware: notation (70%), sequencer (50%),
MIDI interface (50%), sound card(65Yo\, and CD-ROM drive (89%). Other
types of applications were less frequently available: MIDI controller (27Yo),
synthesizer or keyboard (49%\, drum machine (l4Yo), digital audio soft-
warc(l7o/o\,digital audio hardware (11%), MIDI librarian/patch editor (l 1%),
multimedia authorware (13%), instructional CD-ROMs (40%), sound mod-
ule (34Yo), eartraining software (28%), and theory software (38%).

Ninety-eightpercent ofteachers had Internet access and 89% ofschools
had Internet access for students. Regarding uses of the Internet, 44Yo of
teachers reported that it was used for assignments, 9Yo for ateacher Webpage,
and30%o for a school Webpage. Only 6% reported actually using the Internet
in their teaching.
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Other findings:

1.90% of teachers had only 2 or fewer computers for student use.
2.31% reported no funding available for their technology needs.
3.36% reported poor funding for technology.
4.36% said that performance expectations limit their adoption of tech-

nology.
5 .46% found available software to be less than adequate for their needs.
6.750/o reported that learning to use music software was little or no

problem.
7.84% of teachers knew at least one other teacher who incorporated

technology into the music classroom.
8.600/o never received computer training in college.
9.10o/o said that the quality of their university technology instruction

was poor.

A factor analysis showed that there were 5 factors most strongly
related to predicting whether a music teacher was a "computer user" or
not: school environment, teacher experience, access to technology,
teacher training, and suitability oftechnology to curricular goals.

Technology for Real Middle School and l{igh School Bands
Kimberly C. Walls, Auburn University
Joy Brinkley and Shannon Chandler,

W. F. Burns Middle School and Valley High School
Myra Rhoden, Booker T. Washington High School

Teachers are encouraged to use technology in their teaching and have
students use the technology themselves; however, technology should not be
used unless it makes new learning possible or makes learning more effi-
cient. When school ensemble conductors must manage large groups of stu-
dents, it is not clear how all the students may have time to use technology.

This presentation described how two band programs in our area pro-
vided their students unique ways of learning music through technology.
Kim Walls has been privileged to observe these band directors as they fol-
lowed their ideas for instruction from the proposal stage through implemen-
tation. This presentation included video clips of their students in action
using music technology and vignettes of the students assessing their learn-
ing experiences. Summaries of what the students and the teachers have told
Walls about the experiences were presented. Then Chandler, Rhoden, and
Thomas answered Symposium participants' questions about what it is like
to implement technology in band rehearsals.

Initially we observed the band program at W. F. Burns Middle School
and Valley High School in Valley, Alabama. At the time of the presentation,
Shannon Chandler had been band director in Valley for I I years, teaching
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at both schools, and Joy Brinkley had been teaching at both schools for 3
years. Shannon and Joy have a productive professional relationship in which
each of them assists the other in their schools. They team teach middle
school and high school band.

Joy and Shannon have implemented at least two applications of tech-
nology in music learning for band students. Each school has an Amadeus
pitch-to-MlDl converter system that students use for performance assess-
ment. The Amadeus system consists of hardware and software that accepts
audio information, converts it to MIDI, and compares the performance data
with music that is programmed into the system. The software then assigns
the student a grade based upon pitch and rhythm tolerances preset by the
teacher. The system was delivered with scales and exercises from the Stan-
dard of Excellence Method Books. The Amadeus Tutor program allows
teachers to input any type of music via MIDI into the system for students to
perform.

Joy and Shannon have used Amadeus for students' individual pass-offs
of scales and method book exercises. This is an efficient way for students to
receive feedback on their performance and is an efficient means of grading.
Anyone who has graded student performance tapes or tried to schedule enough
private lesson times for their ensemble members would find this option
attractive. Another way Joy and Shannon use music technology is to create
and distribute MIDI files of students' band parts for practice at home. They
have discovered that many ofthe students find the aural models valuable for
learning to perform concert music and that they enjoy their home practice
more.

At this point some video clips from Burns Middle School were played.
In the first clip, Joy demonstrated and explained how Amadeus works. In
the second video vignette five young ladies from the W. F. Burns Middle
School Band discussed using Amadeus. They described what was it like to
use Amadeus the first time in band testing and their general perceptions
concerning the use of the program. They all reported that the system is easy
to use: "If you can use a computer, it's easy." They also said that they
preferred playing their tests for the system in the band director's office
instead ofplaying in front oftheir peers during rehearsal. Joy and Shannon
had worked out a schedule so that each student had two 7-minute blocks of
time per week when they were scheduled to leave the large rehearsal to
perform their pass-off assignments. In the third video episode the girls were
asked about using the MIDI files for home practice. They reported that they
found the MIDI files easy to use and helpful for improving their perfor-
mance. In fact, some of them reported that they still used the files to practice
"old" music. In the last clip, Jessica, a middle school band member, played
a scale into the Amadeus system.

Two years earlier, Myra Rhoden discovered a grant opportunity for
obtaining technology equipment. She had definite ideas about what she
wanted to be able to do for her students. Several ofher students had ex-
pressed interest in composing and arranging music for the band at Booker
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T. Washington High School. She wanted to obtain technology that students
could use during band rehearsals to learn about composition independently.
Consequently, Myra and Walls wrote a grant proposal and the school was
awarded $5000 to purchase four computers, MIDI keyboards, and the fol-
lowing software: Band-in-a-Box, Sibelius, and Music Ace. Over the past
two years, several band students have worked with the hardware and soft-
ware to develop their composing skills. Some of their compositions were
performed by the band. There is no doubt that these students have learned
more about music through these experiences.

A videotape was presented in which the participants met three of the
students of the Booker T. Washington Band who had been using the tech-
nology. The three band members introduced themselves and explained why
they became interested in learning how to compose. Then they used Sibelius
and a MIDI keyboard to perform their compositions. In the next video, the
students discussed how they learned to use the notation software and MIDI
keyboards for composition. Again, they claim that the software was "easy"
to learn.

These three teachers have found ways to enhance student musical learning.
It is impressive that they valued these individualized learning experiences
enough to allow their students to leave rehearsals for small amounts of
independent learning. It is easy to determine from student comments that
band directors Brinkley, Chandler, and Rhoden facilitated these students'
abilities to learn independently. Although the students say "it was easy" and
the teachers made it appear easy, they did a lot of work to make it happen for
the students. First, they had to have the idea: "Technology could help my
students if. . . ." Then each teacher had to find a way to obtain the hardware
and software that they needed. Then after the equipment arrived, they had to
find locations for the equipment to be used, and they had to install all of the
parts.

In addition to all the complications of setting up the software and equip-
ment, Myra spent time outside class to listen to the composers' works and
give them feedback. Although they learned a lot about music notation from
working with Music Ace and Sibelius, they excelled because they had sup-
port from the other composers as well as from their band director. Another
important aspect of Myra's participation in their learning is modeling. The
students could observe her using Sibelius to arrange music that they played
in band performances. Thus, not only did she encourage and direct their
composition, she modeled behavior and shared her work with them.

Shannon and Joy had to select musical examples for assessment and
enter them into the software. They also had to demonstrate and explain to
the students how to use the technology. They developed a schedule for as-

sessment and implemented it. They also had to explain the new teaching
technique to parents and administrators. Even with score scanning soft-
ware, they spent considerable time creating MIDI files for students to take
home.
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Conclusions

Based upon her interviews with the directors and videotaped students,
Walls presented the following important considerations for integrating technology
into band programs.

l. The teacher must be thoroughly comfortable with hardware and soft-
ware,

2. Students need time to work independently.
3. Allow make-up schedules and/or extra time outside of class.
4. Teacher acts as facilitator, and asks questions when students request

feedback.
5. Teachers model technology and musical skills and activities.
6. Logistics of time, space, and technical support are important as-

pects.
7. Students think technology is easy to learn.
8. Students enjoy performing with/for computer.
9. Students practice more (performance and composition).

10. Communication among the working group and teacher facilitates
individual learning.

At the end of the presentation, participants asked questions of Joy, Sh-
annon, and Myra about how they implemented their systems and overcame
obstacles along the way. These band directors gave their assessments of the
effectiveness and efficiency ofusing technology in these ways and pointed
out things they would have done differently.

Software/Hardware

Amadeus al fine: $499 (Win 95/98 or Mac OS 7/8 with serial port) and
Amadeus Tutor; $295. See http://www.pyware.com/amadeus.html

Band-in-a-Box Pro E88. See http://www.pgmusic.com/

Sibelius: $299 and Sibelius S-pack: $899. See http://www.sibelius.com/#3

46 Journal of Technology in Music Leaming. Spring/Summer 2003



The Internet as a Means of
Assessing the New Jersey Core Curriculum

Content Standards in Music: A Research Report
James Frankel, Franklin Avenue Middle School

This session is a follow-up to Frankel's presentation at the 2000 NSMIT.
The results and implications ofthe research are discussed in this session. At
the time of the presentation, Frankel was a Doctoral Candidate at Teachers
College, Columbia University. By sharing the Doctoral Dissertation research
project that he was in process of completing, he hoped to provide music
educators with ideas for creating alternative assessment Web sites for mu-
sic, specifically in regards to standards based assessment, and to show whether
or not the Internet is a valid assessment tool.

There were 22 schools across New Jersey, representing over 400 stu-
dents, which participated in the study. Each school had one class of fourth,
eighth- or twelfth-graders completing online assessment activities in ful-
fillment of the New Jersey Core Curriculum Content Standards in Music.
The teachers submitted student work for assessment, using the Performance
Standards for the National Standards in Music Education. Students submit-
ted audio, visual, and written work for assessment as opposed to the tradi-
tional standardized testing method. This assessment Web site, titled
MusicAssessment.com, contained 18 assessment activities. The data de-
scribed what types of activities worked, and what types did not. Student
work and all of the features contained on the site were displayed.

Overview of the Session

Standards Assessment: Traditional vs. Performance-Based
o What are the advantages and disadvantages of each?
. Which assessment type more accurately reflects student understand-

ing in music?
o What does the assessment for some of the State Standards in Music

look like?
o What are the positive and negative aspects of each?
. What will the results ofthe assessment mean for our music programs?
r What role can technology play in assessment?
o What are the advantages and disadvantages of each?
. How can the Internet be used as an assessment device?

Explanation and Demonstration of www.MusicAssessment.com
. Background on the mechanics of creating the site
. Overview of the site, its features and functions
. Presentation and explanation of some of the activities contained on

the site, at least one from each ofthe three grade levels
. Examples of submitted student work will be shared
. Discussion of the grading rubric and the feedback aspect of the site
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Analysis and Results
o Data from teacher questionnaire
. Number of hits
r Amount of student work assessed
. Time spent grading work to be assessed
. Time spent by teachers submitting student work
. Technical difficulties
. Cost factor
o Feasibility of statewide use
o Questions for further research

Conclusion

A discussion followed concerning the concept of Internet assessment in
the music classroom, results of the data analysis, and the feasibility ofusing
it at the state and national level.

Multimedia Uses of Microsoft Word and PowerPoint
Jane M. Kuehne

Center for Music Research, Florida State University

In contemporary times, educators are most often expected to use com-
puters and software to enhance student learning. While this is the expecta-
tion of school districts, only sometimes the hardware and software that is
provided seeks to meet the needs ofmusic educators and students. Further-
more, with budgetary restrictions that some music programs have, purchas-
ing new and often unfamiliar equipment and software is unrealistic.

Because of the many uses of Microsoft Office, it has become somewhat
of a standard in educational settings and is familiar to many people. There
are two components of Office that educators and students are utilizing in the
classroom, Word and PowerPoint. These fwo components can be used in
many ways, including several multimedia applications. The purpose of this
paper is to inform music educators of practical multimedia applications for
Word and PowerPoint software.

Recording Sound Clips

Using the Windows Sound Recorder will allow recording of short ex-
cerpts without an additional purchase of software. While it may not be the
highest quality of recording, for most beginners it should be adequate. The
quality ofrecorded clips depends upon the preferences and room ambiance.
For the best quality, the recording and playback qualities should be con-
verted from the default to at least CD quality (44,100 Hz, 16 bit stereo).
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To change the properties in the Sound Recorder, click File>Properties.
The Properties for Sound window will appear. At the bottom, select All
Formats and click <Convert Now>. The Sound Selection window (Figure I )
will appear. Under Name, find the quality of sound that is desired (CD/
Radio/Telephone) and then click <OK>. From the previous window click
<OK> and the properties will be changed. To record, use a microphone and
press the red record button as if using a tape recorder or other recording
device.

Figure /. Sound Selection window for the Windows Sound Recorder.
Users can change the quality ofplayback and recording.

Inserting Media Clips

Using Microsoft Word and Microsoft PowerPoint, educators can create
customized pages that can be used repeatedly. Furthermore, once the work
is completed, it is available with the click of a mouse, allowing more time to
move to new projects. Inserting media clips into Word and PowerPoint documents
enhances presentation and puts the tools needed to teach a topic in one
place. The following is a deseription of the steps needed to insert an existing
media clip (sound or video) into a Word document. The process is the same
for PowerPoint.

To insert a media clip, click InserPObject on the File Menu. The Object
window (Figure 2) will appear. From this window, select the type of object
to be inserted. Under Create New, select Media Clip. Check "Display as

icon" to create an icon which will serve as a link to the media file. Double
clicking the icon in the original document will allow immediate access to
the media clip. Clicking <OK> will move to the next step.
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Figure 2. Object window where users can choose the type of object to insert.

When the icon is double clicked in the original document, the Media
Player (Figure 3) should appear. For the icon to link to a specific file, on the
media player click File>Open and select the desired file. Once a file has
been selected and opened, the original document must be updated. On the
media player, click File>Update Document and then save the original docu-
ment.

Figure 3. Media Player where the user can choose the file to play and update
the document.
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Inserting Hyperlinks

Similar to inserting a media clip, creating hyperlinks in documents can
be valuable. Using hyperlinks, educators will be able to create interactive
media pages that require little effort from students. In addition, educators
can use previously created documents on a computer in place of the over-
head projector and/or stereo equipment, depending on setup.

To create a hyperlink, on the File Menu click Insert>Hyperlink. The
Insert Hyperlink window (Figure 4) will appear from which atatget file can
be selected. First, at the top of the window, type the text to display for the
hyperlink. Next, select atatget file. After selegting the target file, clicking
<OK> will complete the process. The hyperlink text will appear as linked
text does in an active Webpage (usually blue and underlined), and a hand
will appear when the mouse is on the text.

Figure 4. Hyperlink Window, where the user can choose a taxget and edit the text for
creating a hyperlink.

PowerPoint Presentation Development

Learning can be reinforced or student-initiated with well-developed
PowerPoint presentations. Important factors to consider when developing a
presentation to be used with students are student age and ability levels as

well as their interests. Because of the time involved in creation, presenta-
tions should include material that will be used repeatedly or extensively,
using some form of multimedia. Two effective media tools for communica-
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tion are photographs and sound. Photos and authentic sounds provide vari-
ety and allow students another path for gaining information.

Another important factor to consider is presentation order, or learning
sequence. For example, an historical presentation should follow historical
events in order of occurrence. Similarly, educational presentations should
be presented in learning sequence order, rather than random. The primary
use for the presentation should be to convey correct and appropriate infor-
mation to the students (or other audience).

Inserting Sounds into PowerPoint Presentations

To create unique presentations, inserting pictures and links to sounds is
suggested. To insert a link to a sound onto a slide, on the File Menu click
Insert>Movies and Sounds>Sound from File (all on the same menu). Select
the desired filb and click <OK>. A speaker icon will appear on the slide. The
software may ask whether or not to play the sound automatically. Choosing
<Yes> will make the sound play whenever the slide is opened. Choosing
<No> will allow the user to click the icon to hear the sound clip.

Inserting Pictures

To insert a picture into a PowerPoint presentation (the process is the
same in Word), on the File Menu click InserPPicture>From File. Select the
file to insert and click <OK>. The selected picture should appear in the
slide. Subsequently, editing of size, borders, contrast, etc. can be done with
the Picture Toolbar (Figure 5), found in both PowerPoint and Word.

Figure 5. Picture Toolbar that allows users to edit inserted photographs
or graphics.

Suggested Software Additions

When using the multimedia functions of Microsoft Office, it may be
desirable to combine them with other software applications. Some suggested
additions in multimedia software for use in the music classroom fall into
two categories: multifunctional notation software and recording and edit-
ing software.

Multifunctional notation software will allow many uses for one price.
For example, it should be able to produce excellent notation that will allow
the user to place every kind of notation into the music. It should also be able
to save in various formats including (but not limited to) MIDI and graphics
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formats (to place into other types of documents), Finale (1987-1999) is
well-known notation software that allows the user save and format in many
ways. New improvements have made it easier to use and have added func-
tionality as well.

Sequencing and editing software should be multifunctional as well. Sequenc-
ing software will allow music to be entered via a MIDI controller (usually a
piano keyboard) and edited in various ways. This type of software can aid
students in the creative process or allow for creation of practice perfor-
mance tracks for everyday use. Cakewalk Home Studio (1991-1999) is an
example of sequencing software that is multifunctional and relatively easy
to learn and use. It allows the user to view and edit entered data in various
ways (notation, piano roll, by track). In addition, it provides ways to edit
single notes, groups ofnotes, single tracks, or groups oftracks.

Editing software allows for editing of existing sounds (for example
from a CD or other sound source). In some cases, existing video can be
edited as well. This type of software can filter and change sound to make it
clearer to the listener. An example of editing software is Cool Edit 2000
(Johnston, 2000), which can extract and edit sounds from various sources.
The user can edit sounds by changing the ambiance (room), filtering out
background noises, editing bumps in tracks, cutting and pasting, fading in
and out, amplifying sounds, and so on. [t can be an extremely useful tool
when editing recordings of groups, or when creating recordings for others.

A Call for Technology in the Classroom

As school districts update and evolve, technology most likely will con-
tinue to be an integral paft of education. New technology will bring new
challenges. As student learning should never cease, neither should educa-
tors' learning stop. Technology can be a friend and ally in the classroom;
and more importantly, it can aid in maintaining student interest in subject
matter.

Music lends itself easily to the use of technology. With the many differ-
ing and ever-changing possibilities for its incorporation into the classroom,
music educators should be at the forefront of its use and on the cutting edge
of finding creative uses for new and existing hardware and software.

References
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Service-learning & Music Technology: Connecting College
Classrooms with the Community
Melissa Berke and Kenton Bales
University of Nebraska at Omaha
Margaret Pavlik and Therese Laux

Omaha North High School

This presentation outlined the role of service-learning and the ways
technology can assist with music education service-learning projects. Re-
searchers discussed a partnership that exists between the University of Ne-
braska at Omaha (UNO) and North High School of Omaha Public Schools.
Additionally, researchers shared plans for a new low-cost lab and applica-
tions of music technology for several other service-learning opportunities
(see Figure below)

Univenity of Nebrasks st Omaha

Dcp.rtmcnt
&

SMART Proist
rl

North

COMPATIBLE MISSION STATEMENTS TJNIVERSITY/SCHOOL COMMIJNICATION

SERVICE.LEARNING ACADEMY AT UNO FLEXIBI,E GOALS

In the past 10 years, there has been an increase in college classroom
activities that allows students to see a connection between the academic
content and its application to real-life settings (Gray et al, 2000). Many
individuals in higher education feel that linking learning to settings outside
the classroom walls is crucial to the development of students as responsible
citizens. Activities that integrate community service with academic study
are known as service-learning. Service-learning projects are designed in
partnership with community organizations to meet the genuine needs in the
community while advancing student understanding of course content. In
the community setting, students work as volunteers; on campus, they reflect
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on their service experience, considering its relationship to their course ob-
jectives as well as the impact of the service on personal values and profes-
sional goals.

Service-learning projects can occur at all educational levels. The focus
of this project is middle school, high school, and collegiate students. Be-
cause the needs of the community determine the types of collaborative op-
portunities that can be developed, it is important to provide some back-
ground information about the community on which this project was based.

Omaha, Nebraska is a metropolitan are with a population of 700,000.
The largest and most diverse school district in the state is the Omaha Public
Schools (OPS), which serves 45,199 students in seven high schools, l6
middle schools, and 60 elementary schools. One of the educational aims of
the district are community partnerships that link students internally and
externally with entities in the community such as families, students, staff,
businesses, as well as the general public.

North High School serves as the district's mathematics and technology
magnet. It also is an inner-city school that was the recipient of a 21"'century
community learning center grant from the U.S. Department of Education.
This grant provides financial support to rural and inner-city communities
for after school centers that provide academic, cultural, and recreational
opportunities for the community members. A portion of the funds from this
grant was used to develop a music technology lab.

The University of Nebraska at Omaha is part of the state university
system. There are approximately 12,000 undergraduate students and 2,500
graduate students that attend each year. Because the institution serves as the
state's metropolitan university, one of institutional missions is to seek op-
portunities to engage with the community. The University is very commit-
ted to service-learning and supports collaborative endeavors through its
service-learning academy.

With community involvement as a common goal, the University Music
Department and the North High Music Technology Laboratory were poised
to develop some serviceJearningprojects. The firstprojectinvolvedagraduate
course in music technology at North High School taught by IJNO faculty.
The University also provided a student intern who worked with high school
students on various music technology applications as well as provided tech-
nical support for the workstations.

While these initial projects were considered successful, the researchers

identified two factors that hindered the service-learning connections from
being fully realized. The first challenge was the type of technology avail-
able within the music department. Additionally, the service-learning com-
ponents for coursework were not fully complete. To alleviate the equipment
problems, researchers proposed a cost-effective, high-tech lab that was par-
tially funded by the University of Nebraska Foundation.

With more compatible equipment available, additional service-learn-
ing opportunities have been planned for music education coursework as
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well as music courses for non-music majors, specifically elementary educa-
tion majors. Below is a summary of projects planned for each level.

In elementary methods courses for music majors, live-link observa-
tions will be possible. This use of technology will allow music education
majors to observe elementary music classes in a less obtrusive manner.
Digitally recorded lessons will allow students to view a lesson or event
multiple times. In a middle school methods course for music education ma-
jors, students will serve as mentors to middle school students in an elec-
tronic "Composer-In-Residence" project. The college students will be su-
pervised by a faculty composer. The goal will be to have student works
submitted for the MTNA composition contest.

Like the elementary methods class, the lab will allow elementary edu-
cation majors who are enrolled in Music Fundamentals for Elementary Teachers
to observe music teaching. Because many of the students enrolled in the
course have no previous music experience, the lab will provide several music
fundamentals programs that will help students who need additional drill. It
is planned that music education majors could help these students as an addi-
tional service-learning experience.

Service-learning is becoming an important part of college coursework
on many university campuses. As college educators, it is important to give
students opportunities to build teaching skills prior to their student teaching
experience. Technology can help facilitate both ofthese needs in very cre-
ative ways.

On-Line Resources for Service-Learning

American Association of Higher Education http://www.aahe.org/

Campus Outreach Opportunity League http://www.COOL2SERVE.org

Campus Compact

National Service-Learning Clearinghouse

Service-Learning

http ://www.compact.org

http ://www. servicelearnin g.or gl

http ://csf. colorado. edu/sl/
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Using the Web to Learn about Multicultural Music: From
College

Students to K-8 Students
Cecilia Wang, University of Kentucky

This project was an attempt to integrate technology within the context
of a college General Music Methods course. Apart from using computer
notation software to present students' individual original compositions, students
worked in groups of four or five on a Web multicultural lesson project. This
three-week Webproject also provided students skills in writing lesson plans
according to given learning standards. Furthermore, the Web lessons cre-
ated by the students were shared with school music teachers who in turn
provided feedback regarding the Web lessons. Teachers also were encour-
aged to field test these lessons with their school children. It was hoped that
such partnerships would benefit everyone and promote more communica-
tion among music educators and students of all levels. The specific goals
are listed below.

For college students:
o To use technology in Methods class
o To introduce music of different cultures
o To create study guides

For school teachers:
o To provide information about multicultural music resources
r To communicate as parhrers in music education

For school children:
o To access lessons on music of different cultures on the WWW
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For the college professor:
o To obtain feedback fromthe school teachers
o To obtain feedback from college students and school students

Method

Students in the General Music Methods class (Fall2000 semester, N:
29) were assigned a group project with the following objectives.

o To gain experience working in a collaborative environment
o To gain knowledge and understanding in music of different world

cultures
o To find references and teaching materials in the Internet
o To develop skills in using technology with music education
o To implernent music standards via lesson planning
o To get acquainted with assessment of music leaming

Students were given the following tasks:

1. Production of computer notation of each mernber's Orff composition
using notation software

2. Production of a Webpage on one nonwestern music culture
3. Teaching of a music lesson on the chosen nonwestem music, using a

lesson plan and specific listening guide developed by the team

4. Presentation of the Webpage and an accompanying study aid for the Web
unit

5. Writing a reflection statement about the project

To aid the students, the instructor provided the following information:

o Project guidelines
o Web assignment
o Sample Web lesson /study guide sheet for school children and outs and

resource lists

In the spring semester, the instructor invited school music teachers to
view the Web project and evaluate the usefulness of its format and content
for their students to learn about music of different cultures. They were given
guidelines to provide specific feedbacks. Responses were sent by means of
e-mail to the college professor.

Results

The college students completed their assigned tasks as given. Six Web
lessons were created by students in groups of 4 or 5 over three weeks. Stu-
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dents did their research in the library as well as through the World Wide
Web. All the Webpages contained at least one picture and five links to other
resources. The Webpages were designed in color and two included audio.
These pages of music from different cultures can be viewed at the following
sites.

o Australia [http://www.uky.edu/-ceciliafivfUSlC/Australia]
o Brazil [http//www.uky.edu/-ceciliarlUUslC/Brazil]
o Caribbean [http//www.uky.edu/^ceciliarl{USlC/Caribbean]
. E gypt [http //www.uky. edu/-ceciliafir4USlC/Egypt]
o Hawaii [http//www.uky.edu/-ceciliaIvlUSlC/Hawaii]
o Native Americans [http://www.uky.edu/-cecilia/I{USlCNativeAm]

Music teachers provided the following feedback:

Positive features:
o Easy navigation
o Attactive pictures
o Links to other resources
o Inclusion of other arts
. Good organization
. Overall qualrty
o Start with audio
o Built-in study guide

Negative features:
o Reading level of text is too high
o Commercials

Adaptability:
o Suitable for 56 grade or higher as is
o Adaptable for lower grades

Suggestions:
o Koepthepictures
o Maximize attactiveness
o Make it simple
o Show text in small chunks
e Use consistent, "kid-friendly'' language
r Proofread the text
o Use more sound, audio, authentic music!
e Present cultures to align with core cont€nt required by the state (West

African" Appalachian, Jazz)
o Provide captions for pictures
o Provide systernrequirements foraudio clips
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Both college students and school children expressed having good learning
experiences from the project. Teachers were happy to have additional re-
sources to use for instruction. School children enjoyed learning from the
Web. It was concluded that Web sites created by college students can be
applicable for use by school children and that it is beneficial to integrate
technology, multicultural music learning, and partnerships with teachers
and students. The teachers' comments provide important suggestions for
improvement on future college technology projects.

(This presentation is available at: http://www.uky.edu/-cecilia/nsmit )

The Art of Inaccuracy
Greg Woodward

Center for Music Research, Florida State University

Music educators continue to discsver how MIDI can be used to teach
students to be more creative. The elements of the creative musical process
are being redefined because of the role of computers in composition. Fur-
thermore, the elements of the creative process are being redefined from a

postmodern perspective. Borgo (1999) explained how chaos theory helps
explain the complexity of music at a micro level. Borgo suggested that the
performance gesture is an integral part of the creative process. The quanti-
tative potential of the computer is essential in standard composition. How-
ever, creative musical gestures are achieved through aural preference as
opposed to quantifiable decisions. Music educators can help students achieve
artful inaccuracy by making them aware of the role of inaccuracy in music
and showing them how artful inaccuracy can be achieved in a MIDI file.

Students have the opportunity to play at least four roles in a Musical
Instrument Digital Interface (MIDI) class (i.e., composer, performer, sound
engineer, and computer technician). The potential for MIDI to serve as a
tool in composition has been readily recognized: "A sequencer can be thought
of as a box of musical 'crayons' for the music student" (Rudolph, 1996, p.
130). However, teachers and students often fail to realize the potential of
MIDI performanc€ (i.e., creative gesture at the micro level).

Muro (1993) referred to the manipulation of MIDI data as the "art of
sequencing." These manipulations could also be referred to as the "art of
inaccuracy." The computer was developed on the premise that mathemati-
cal logic could be used to perform mechanical operations (Hodges, 2001).
The computer tools that contemporary composers use via the computer are
based on the ability of the computer to count accurately. However, accurate
counting does not equal artistic performance. For example, an experienced
sequenc€r technician rarely quantizes at 100%. Currently, the human ele-
ment is unique in determining what sounds best at any particular moment in
a sequence.
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MIDI production also can be considered an art of inaccuracy because
MIDI replicates a complex phenomenon. Borgo (1999) offered a new per-
spective on the complex interaction of the human element in music. Borgo
explained chaos theory, and then applied chaos discoveries to various ele-
ments in music. He stated that many phenomena only could be explained
with chaos theory. For example, weather patterns cannot be understood
using linear logic. As computers developed within the twentieth century,
eventually meteorologists became more successful at tracking complex weather
patterns.

Borgo (1999) suggested that music also is a complex phenomenon that
cannot be explained with linear logic. For example, one might assume that
all variables of performance are controlled in a composition. However, two
accurate performances of a string quartet will show differences in gesture
interpretation at a micro level. Borgo acknowledged that these differences
are exaggerated in improvisation. Hence, a continuum of free interpretation
exists from the most controlled musical experience to the least controlled
musical experience.

Because of a greater understanding of gesture in the creative process,
performance now may be reevaluated as creative property in a finished work.
Historically, performance subtleties have been recognized as recreative gestures
but not always recognized as original musical thought. Within folk genres
(e.g., blues), the performance gesture may be as important as the actual note
played in the creative process. Borgo (1998) explained that recording pos-
sibilities have redefined "literate" and "non-literate" musical creation. Because
sound can now be edited, previous distinctions between the process ofcre-
ation in oral and non-oral traditions no longer exist. If only MIDI data or
sound clips are manipulated in the future of music composition, the perfor-
mance gesture might becotne an essential part of the creative process. Lim-
ited notational representation of such gestures may hold nominal signifi-
cance. However, current copyright laws perpetuate continued reliance on a
limited categorization of creative musical thought. For more information,
Baskerville (2001) offers an excellent review ofcopyright law in the con-
text of technological production.

Recognizing the presence of creative gestures in music is only a first
step in the process toward replication of such gestures. The MIDI teacher
must also consider how artful manipulation of MIDI data can be achieved.
Artificial intelligence might offer insight into how creative gestures occur.
The computer's replication of human gestures could give teachers quantifi-
able tools in teaching creative gestures. Bresin and Friberg (2000) com-
pared the effect of computer replications of human musical gestures catego-
rized as seven separate emotions. The researchers found a significant rela-
tionship between intended emotion and perceived emotion. One avenue for
teaching the creative gesture to students might be to encourage students to
copy the gestures the computer used to produce various emotions. How-
ever, the study did not offer data to help students replicate subtle human
artistic gestures. Bresin and Friberg examined emotional differences at a
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macro level (i.e., the formula for angerwas applied to the entire piece). The
test failed to recognize the subtle differences that can occur in human per-
formance from one time frame to the next time frame.

Rychlak (1999) stated that current artificial intelligence.is unable to
replicate actual human thought. According to Rychlak, computers always
choose the next action based on logic. In reality, choices are made about the
next thought or action based on choice. The choice may not be the most
logical mathematical choice. The capacity to make illogical choices may
separate human sequencing from sequencing based on artificial intelligence.
The ability to choose a particular musical gesture because it "sounds right"
is why human music creation is an "art of inaccuracy."

Currently, complete understanding of how creative gestures occur is in
a relatively early stage. However, MIDI teachers can make steps toward
developing creative gestures in students by using available information.
Teachers can enter a three-step process toward enabling artful sequencing
in students. The first step in the process is recognizing the unique potential
of individual students. For some time music therapists have recognized
improvisation as a means toward understanding their patients. Often music
educators are guilty of prescribing creative remedy for the student without
truly understanding the student's personality. As research progresses, one
day teachers may be able to decipher a great deal regarding the personalities
ofstudents by analyzing their creative gestures. Even ifthis type ofanalysis
never progresses toward exact science, teachers at least can become more
aware of student potential at the creative gesture level.

Next, the teacher can make students aware of their creative potential.
Students can be made aware of the power of data manipulation through
teacher demonstration. Gaber (personal communication, 1999) showed how
various types of artful inaccuracy could be achieved within a short section
of music.

Finally, students are encouraged to experiment with the "art of inaccu-
racy." They are encouraged to take chances in their pursuit of what sounds
right. Integrity is maintained at this level of experimentation by encourag-
ing students to play their MIDI files for other students or the teacher.

References
Baskerville, D. (2001). Music business handbook and career guide. (7th ed.).

Thousand Oaks, CA: Sage Publications.
Borgo, D. (1999). Reverence foruncertainty: chaos, order, and the dynamics of

musical free improvisation (Doctoral Dissertation, University of
California, Los Angeles, 1999), Dissertation Abstract International,
9947057.

Bresin, R., & Friberg, A. (2000). Emotional coloring of computer-controlled
music perform ances. Computer Music Journal, 2 4(4), 44-63,

Hodges, A. (2001). The Alan Turing Home Page. [online]. Available Internet:
www.turing.org.uk

Muro, D. ( I 993). The art of sequencing: A step by step approach. Miami: Belwin-
Mills Publishing.

62 Joumal of Technology in Music Learning . Spring/Summer 2003



Rudolph, T. E. (1996). Teaching music with technology. Chicago: GIA Publica-
tions.

Rychlak, J. F. (1999). Social constructionism, postmodernism, and the computer
model: Searching for human agency in the right places. Journal of Mind
and B ehayior, 2 0(4), 37 9 -390.

Teaching Student Composers to Use a Desktop
Audio Workstation and Digidesign Pro Tools

John Jinright and Randal Boone
Troy State University

In this presentation, a university instructor (Jinright) described how he
set up a digital audio workstation at minimal cost for use by his music stu-
dents. One of the music students (Boone) demonstrated how to use the tools
and played examples of student compositions.

The workstation consists of a Digil00 USB digital mixer, an amplifier,
two Alesis monitors and a Windows based computer. Microphones were fed
through a compressor before sound was mixed. An inexpensive battery powered
alarm from Radio Shack was installed for security reasons. The software
programs Acid and Pro Tools were used to capture and edit the sound. The
software and equipment allowed students to freely compose, record, mas-
ter, remix, and synchronize music with video.

Survey of Music Education Technology
at Colleges in the Southeastern USA.

Harry E. Price and Kok Chang Pan, University of Alabama

The purpose of this study was to collect data concerning the implemen-
tation of technology in Southeastern United States music education pro-
grams at the college level in NASM accredited music education degree pro-
grams. Participants (N: 69) from the southeast completed a questionnaire,
providing curriculum, facilities, and personnel data regarding music educa-
tion technology. The results showed that not all of the colleges surveyed
have adequate staff and facilities to provide music education technology
courses to their students. The principal concerns expressed were resources,
trained instructional personnel, and a dearth ofresearch on the effective-
ness ofmusic education technology. The study also discussed issues faced
by music faculty in implementing music education technology.

Note. See the Journal of Technologt in Music Learning, I(2), pp. 56-66, for Price
and Pan's peer-reviewed complete article.
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Insights and Strategies for Developing
a Music Technology Program

Margaret Pavlik and Therese Laux
North High School, Omaha, NE

Do you have a dream of having a music technology program? Do you
want to make it a reality? This presentation illustrated how a large metro-
politan high school turned this dream into a reality through a federally funded
"2lst Century Community Learning Center" grant. We also described how
Omaha North High School's music technology center serves the needs of
students during and beyond the school day. We explained how Omaha
North developed a music technology program, beginning with physical setup
to integrating technology into the music curriculum as well as other disci-
plines.

The presenters provided an information packet for participants that in-
cluded a description of North High School' s Music Technology Center with
a list of hardware and software, a resource list of vendors and industry
contacts, information on applying for a "2l st Century Community Learning
Center" grant, a variety of sample lesson plans for music technology at the
secondary level, and a list of related Web sites.

An outline of the presentation follows.

l. An overview of technology in rnusic education
. Technology in our world: Technology as a resource and tool
. Students and technology: Active learning
. What music technology can do for your students

2. Funding sources for technology
. United States Department of Education: 2lst Century Community

Learning Center
. Other sources of funding
. Managing projects and funds

3. Computer Systems and Lab Management
. Physical setup: space, furniture, and wiring
. Suggested hardware and software
. Lab management and security

4. Teacher Strategies and Student Activities
. National Standards
. Music Technology competencies

5. Resources for Educators
. Technology Institute for Music Educators

' Organizations
. Web sites

6. Showcase of Student Work and Activities

64 Journal of Tecbnology in Music Leaming. Spring/Summer 2003



Integrating Web based Learning and Instruction
into a Graduate Music Education Research Course:

An Exploratory Study
Nancy H. Barry, University of Oklahoma

Abstract
The purpose of this study was to develop and evaluate Web based compo-
nents for a graduate music education research course. The first phase ofthe
study began with development of two types of Web based materials for a

music education research seminar. On the basis of student outcomes, stu-
dent comments, and a generalized impression of the course, this instructor
believes that the Web based components of this course were successful with
higher student test scores resulting from Web based portions of the course
in comparison with the more traditional instructional units. The second
phase of the study was carried out with twelve graduate music education
students enrolled in a similar music education research course at a different
university. Student and instructor recommendations from Phase I resulted
in certain modifications to the instructional procedures used in Phase II. In
order to compensate for the lack of communication during the Web lessons

that was cited as a problem during Phase I, e-mail communication with the

instructor was emphasized during Phase II. Unlike the first course, in which
Web based and on-campus instruction were blocked in relative large units,
the calendar for Phase II was designed with Web based and traditional in-
struction alternating throughout the course. Data from the second phase of
the study generally support the findings from Phase I. However, with this
larger group of students, greater diversity in the degree of Web use was
observed.

Introduction

Web Based Learning and Instruction (WBLI) holds many advantages

for learners, particularly adult learners who must balance school with pro'
fessional and home responsibilities (Brown, 2000; Keating & Har gitai, 1999;
O'Leary, 2000). In a study conducted at the University of Central Florida,
adult students identified the following benefits of WBLI (Hudson, 2000):

1 . Ease of communicating helps students to interact with on-line class-

mates and to develop even closer relationships than they would with
"live" classmates.

2.WBLI courses provide opportunities to search the Web and master
computer skills that are essential in today's world.

3.WBLI enables students to communicate with other students and their
instructors at any time throughout the day, making it easier to share

information and ask questions.
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4.The flexibility of WBLI allows adult students to continue to meet
family and job responsibilities while pursuing an education.

5.WBLI helps students to develop self-sufficiency and to engage in
independent thinking and research.

Reduced costs, accessibility, flexibility, and improved technological
capabilities have resulted in an increasing interest in WBLI among higher
education institutions and faculty (e.g., Bonk & Dennen, 1999; Brown, 2000;
Childers & Berner, 2000; deVerneil & Berge, 2000; White, 2000; Shave,
r 998).

Research indicates that both undergraduate and graduate students hold
generally favorable attitudes about WBLI (Angulo & Bruce, 1999; El-Tigi,
2000). However, students still have many misgivings about taking a course
entirely through the Internet (Angulo & Bruce, 1999).

Implementation of WBLI certainly takes many forms. Shave (1999)
described four models of using the Internet for course delivery:

l.Informational (Level 1). The Internet provides relevant course in-
formation such as syllabi, calendars, and announcements.

2. Supplementary (Level2,). Other resources are included in addition to
informational materials such as additional references and practice
materials. Supplementary materials are not required for the course,
but may enhance the learning.

3.Dependent (Level3,). Students must use the Internet to access major
course components. This level includes additional materials beyond
the Informational and Supplementary levels.

4.Fully On-line (level 4). The entire course, including materials and
activities, is on the lnternet.

In a similar vein, Reeves and Dehoney's (1998) ongoing qualitative
study of faculty use of the Internet at the University of Georgia identified
six functions:

l.course management
2.instructional text
3. instructional graphics
4.Internet resources
5. software
6.communication

Research indicates that WBLI can be as effective as traditional instruc-
tion in terms of student test performance (Germain, Jacobson, & Kaczor,
2000; Teeter, 1997). McCollum's (1997) study of a college statistics class
indicated significantly higher midterm and final exam scores for students
participating in an online version of the course in comparison with students
in a traditional classroom version ofthe course.
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Duchastel (1996-97), however, points out that merely using the Web to
support a traditional model of university instruction fails to tap into the full
potential of WBLI. A six-point model of WBLI is proposed: (a) specify
goals, (b) accept diverse outcomes, (c) request knowledge production, (d)
evaluate at task level, (e) build learning teams, and (0 encourage global
communities.

Exclusive use of WBLI in lieu of traditional instruction may make it
difficult to cultivate a "community of scholars." A case study of an online
graduate course revealed that students perceived a lack of interactivity be-
tween students and their instructor and that the "graduate school experi-
ence" was diminished for some participants (Baylen & Tyler, 1998). Simi-
lar findings were reported in Donaldson and Thomson's (1999) study of
undergraduate college students' communication preferences.

WBLI is a complex process involving a number of interrelated needs,
concerns, and expectations on the part of both the learner and the instructor.
Because of this complexity, qualitative approaches are recommended for
WBLI evaluation (Baylen & Tyler, I 998 ; Michalski, 2000; Reeves & Dehoney,
r ee8).

The purpose of this study was to develop and evaluate Web based com-
ponents for a graduate music education research course. Qualitative meth-
odology was employed in this exploratory, action research project. Using
different data sources and/or different data collection techniques in qualita-
tive research helps to insure dependability of results, a process sometimes
called triangulatiol (Bogdan & Biklen,l998). Data sources in the present
study included student interviews, written student course evaluation narra-
tives, numerical student course evaluations, student tests and products, and
my (the instructor/researcher's) field notes and journal entries.

Phase I

The first phase of the study began with development of two types of
Web based materials for a music education research seminar: (a) materials
to supplement traditional classroom instruction, such as the course syllabus
and calendar, links to useful Web sites, and review questions with sample
responses; and (b) materials to be used in lieu of traditional on-campus
classroom instruction (i.e., "virtual lectures" with links to Java applets and
gif images illustrating various course topics, and practice qluizzes over each

unit of material). This was a small scale exploratory study with relatively
modest integration ofWeb based components within the context ofthe course.

The course calendar consisted of approximately 65%o traditional classroom
instruction with Webbased supplements (students attending classes on campus
with access to additional readings and materials on-line) and 35% Web
based instruction (students participating in Web based lessons off-cam-
pus). Four graduate music education students enrolled in a summer re-
search seminar participated in this phase of the study.

Proceedings 67



Data sources included my journals and field notes, student products
(quizzes and other assignments) and an anonymous course evaluation form
which students downloaded from the course Web site and returned in ad-
dressed postage paid envelopes that were distributed on the last day ofclass.

Findings from the first phase of the study indicated that students found
the combination of Web based classes with traditional classroom instruc-
tion motivating and effective, with all students rating the Web based les-
sons as "Extremely effective" on the evaluation form. Open-ended items on
the evaluation form included:

What were the greatest strengths of the Web lessons?
"I could study whenever I want and spend as much time as I want reading

and taking notes." "I could leam at my own pace."

What were the greatest weakness of the Web Lessons?
"Lack of interaction." "Couldn't ask questions."

Please describe any ways that the Web Lessons could be made more
effective.

"Putting only the material that we should know on the Web or having an
outline for reading. Sometimes I got too deep into the material, because

I couldn't figure out what exactly I was supposed to read."

Do you have any other suggestions or cornments regarding the Web
Lessons? Ifso, please elaborate.

"I don't know if it would work, but I think it would be good to have 40/60
proportion of Web to classroom lessons. On Web we can read about
types of research, and other things, and in class could do math and
address the questions. It would be good to have the schedule when we
switch from the classroom to Web and back every other or couple days."

While they appreciated the convenience of the Web based lessons, the
students indicated reservations about taking a course in which 100% of the
classes would be Web based. The course calendar was arranged with the
block of Web based classes sandwiched between two blocks of traditional
on-campus classes. The students and I found this arrangement to be effec-
tive. Howeyer, some students also suggested alternating Web based and
traditional instruction throughout the course and increasing the proportion
of Web based lessons. Examination of student test responses and other
products indicated high levels of content mastery under both instructional
conditions.

Phase II

The second phase of the study was carried out with 12 gradtate music
education students enrolled in a similar music education research course at
a different university. Web based materials developed in the first phase of
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the study were refined and were incorporated into the second course. Stu-
dent recommendations and my own reflective journal and field notes from
Phase I resulted in certain modifications to the instructional procedures
used in Phase II. In order to compensate for the lack of communication
during the Web lessons, cited as a problem during Phase I, the emphasis
upon e-mail communication was increased. I made a point of e-mailing
students frequently and encouraging students to e-mail theirquestions, comments
and concerns to me. Unlike the first course, in which Web based and on-
campus instruction were blocked in relatively large units, the calendar for
Phase II was designed with Web based and traditional instruction alternat-
ing throughout the course.

Data sources included my journals and field notes, student products
(quizzes and other assignments) and an anonymous course evaluation form
which was completed during the last class meeting, collected by a student
monitor and returned to the instructor.

Data from the second phase of the study support the findings from Phase
I. Students found the incorporation of Web based course components both
useful and motivating. Most students found the increased use of e-mail
communication helpful. The only exception was one student who explained
"If I had e-mail at home, it would have been [useful] but since I don't it was
an extra step to e-mail assignments." As in Phase I, these students ex-
pressed generally favorable attitudes toward the Web based components of
the course: "[t provides a lot of interesting and useful URLs and it saves
time. . ." "Yes lthe Web site was helpful]. . . . I've never been in a class that
tried to do this." "Yes. I can find a lot of information." Nine students
reported fairly extensive use of the Web site, exploring links for additional
reading and information on course topics. However, with this larger group
of students, greater diversity in the degree of Web use was observed with
three students indicating that they only used the Web site to meet specific
assignments: "I did not use it unless assigned."

Discussion and Conclusions

Results of this study are consistent with El-Tigi's (2000) survey of
142 students, finding that students held generally positive attitudes about
their course Web site and that course Web sites were perceived to save time,
provide 24-hour accessibility to resources, facilitate course preparation,
and provide for increased understanding ofclass expectations and objec-
tives. These students responded to rtrBLI in much the same manner as the
graduate students in Angulo and Bruce's (1999) study: Despite generally
positive attitudes, they held misgivings about taking a completely Web based
course.

Both student data and my field notes and journals indicate that WBLI
was as effective as traditional classroom approaches. The conclusion that
WBLI is appropriate and effective for a graduate music education research
course is consistent with the high level of satisfaction reported in Baxter
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and Miller's (1998) survey of faculty with experience teaching graduate
courses via the Internet. Unfortunately, with only a 38% return rate, the
generalizability of Baxter and Miller's findings is questionable.

The ongoing process of developing and testing the relatively modest
Web based materials described in this paper required many more hours than
I had anticipated at the outset of the study. My experience in this study was
consistent with other research indicating that developing and maintaining
course Web sites is extremely time consuming (Baylen & Tyler, 1998; Tee-
ter,1997). While WBLI holds much promise as an instructional tool, issues
concerning faculty workload and credit continue to present challenges. A
report by the Web Policy Committee at the University of Oregon (Bothun,
et. al, 1995) pointed out the importance of providing faculty incentives for
development of WBLI materials and recommended that administration de-
velop an explicit policy regarding tenure-related credit and/or consider-
ation for merit based pay increases.

It is important to note that this study was conducted with graduate stu-
dents, learners who generally were highly motivated and had well-devel-
oped study skills. tt is likely that a modified approach would be required to
achieve similar success with less sophisticated learners. For example, a
recent study ofundergraduate students revealed a lack ofmotivation to use
course Web sites without some specific incentive such as an assignment or
course requirement (El-Tigi, 2000). In contrast, Teeter (1997) found that
students in an online education course had higher motivation than students
in a traditional classroom course.

According to Baylen and Tyler (1998) "The Web can become a static
learning environment if interaction is not occurring between the learner,
content, instructor, or technology" (p. 10). The WBLI in the present study
used informational and supplemental materials and, in some cases, even
utilized Web-dependent materials (Shave, 1999). While effective, however,
these materials failed to tap into the full potential of WBLI. Students en-
joyed having ready access to the instructor via e-mail, but, while some in-
formal student collaboration did occur, communication and collaboration
among students was not supported by this course. Future versions of this
course should allow for more student communication and collaboration so
that a true on-line learning community develops (Dial-Driver & Sesso, 2000;
Donaldson & Thomson,1999; Hudson, 2000).

Results of this study indicate that Web based components can provide a
useful supplement to traditional classroom instruction and, in some situa-
tions, can serve as a valid substitute for traditional on-campus instruction in
graduate music education research courses. This exploratory study was
field based and quite small in scope, and cannot be generalized to other
situations. More research is needed to explore fully the implications of
WBLI for higher education.
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The Creative Music Project: A Pilot Study
in Teaching Musical Understanding
and Composition In Public Schools

David Sebald, Institute for Music Research
The University of Texas at San Antonio

In the spring of 2001 the Institute for Music Research (IMR) at the
University of Texas at San Antonio began a pilot creative music technology
project in Northside Independent School District's (ISD) nearby Monroe
May Elementary School. This project, which lasted from late January to
April, was not experimental in nature; it was designed simply to indicate
initial feasibility, to point the way for more focused future studies, and to
hint at answers to a few broad questions. The questions were: (a) Can a
music technology composition program be implemented in a typical school
computer lab using inexpensive, off-the-shelf music hardware and software
tools? (b) Can normal students (notjust the musically gifted) learn to create
"real" or "quality" music effectively using these tools? (c) Can such a

program be implemented within the parameters of a standard public school
curriculum? (d) What teaching approaches seem most effective at encour-
aging musical creativity using technology?

Northside ISD and May's faculty supported the project generously. Over
the eight-week period the IMR was given access to May's 25-station com-
puter lab every day and to each ofthe four fifth-grade classes, nearly 100

students total, once per week, Monday through Thursday. The laboratory
computers were Pentium 133 MHz machines with 32MB RAM and 2 GB
hard drives. A grant from Texaco Corporation allowed us to install better
quality LabTec LT 835 Headphones, Creative's SoundBlaster Live Audio
Cards, and Cakewalk Express sequencing software on each machine. Cakewalk
Express is a fine basic MIDI sequencing program that is included free with
each SoundBlaster Live card. The cost of all these items was only $120 per
machine. That is amazingly inexpensive compared to similar quality music
hardware and software ofjust a few years ago. The IMR also purchased 25

of Creative's new BlasterKey Keyboards at approximately $89 each-also
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amazingly inexpensive. These keyboards are sturdy and designed specifi-
cally to work with SoundBlaster Live cards. Unfortunately time and space
limitations in the lab did not allow us to use them.

The time limitations imposed before the project began-eight meetings
of less than 30 min each-meant that we would have either to superficially
cover the many aspects of music creation or delve more deeply into one
element. We chose the latter course, opting to emphasize the element of
form and touching on other elements like rhythm, texture, and harmony
only when necessary to explain structural qualities of the music we used.
The element of melody was emphasized, also, but only because it demon-
strated easily recognizable structural features.

We also chose to limit musical examples to the popular idiom. This
musical genre is not only more accessible to a majority of fifth-grade stu-
dents, it almost always clearly demonstrates the structural concepts we wanted
to teach. We did have to be quite careful to select music with acceptable
lyrics and subjects.

lSle planned from the beginning to show a tangible product from each
student at the end of every session. That product would be a short musical
composition demonstrating the student's grasp of that day's musical con-
cepts in an original manner. (Composition in this case means a MIDI se-
quence, not notation.) Each composition would be displayed on a dedicated
project Web site and would serve as both a demonstration of competence
and a motivational factor for the student.

We prepared oral presentations and many illustrated handouts for each
session's concepts. The handouts were to act as "how-to" reference mate-
rial as students manipulated the concepts on the computers. However, we
soon found that a more expedient way of really connecting concepts with
student product was to preset each station's sequencing program before a
session with a template.t These templates-actually just prepared partial
songs and pre-selected sets of tools-made it easier for students to focus on
individual concqlts and work within the boundaries oftypical musical structures
as detailed below. We did not feel that their use restricted creative freedom
but rather, as Stravinsky stated in his Harvard Lectures, that boundaries are
required for creativity.

Each session followed a schedule similar to the following model.

1. Instructor arrives and presets 25 machines:
2. Students arrive and instructor presents concepts:
3. Students work on computers and instructor writes

observations:
4. Students save work and then gather to hear samples of

previous week's output:
5. Students leave and instructor resets machines:

15 min
l0 min

l5 min

5 min
5 min

In addition to the daily schedule above, we followed a weekly schedule
of preparing handouts and other multimedia materials, At the end of each
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week we collected, analyzed, and formatted each composition for the Web.
We also gathered and organized our written observations at week's end.

The musical concepts we wanted to relay to the students over the course
of the eight weeks primarily were structural; that is, they related to how
typical popular music is laid out. Below is a partial list of the concepts we
presented:

e To make music, just organize time with sound.
o Repetition of recognizable sounds or sound pattems helps us organize

time.
e Sounds and sound groups always happen over evenly spaced instants of

time.
o In music, instants of time (beats) are usually grouped in 4s.
o The groups themselves (and groups of groups) are usually grouped in 4s
o In popular music the beat happens between 100 and 138 times per min.
o We can make music more "rock-like" by emphasizing beats 2 and 4.
r Patterns can be made more recogrrizable by avoiding long sounds.
o Music often is constructed in layers (drums, bass, harmony parts, lead

line)
o Melodies are monophonic and show shape.
o Melodies contain repeating rhythms and up-down pattems.
r Melodies follow the beat and meter of the music.
o Repetition of recognizable melodies helps organize a whole piece of

music.
o Short songs typically use a three-part format for repetition (ABA)
o A common format for repetition in longer songs is Rondo (ABACA and

its variants).
o All musical rules can be bent or broken but only a few at a time.

What the CMP Pilot Taught Us

This project was not an experiment; that is we did not attempt to collect
statistical data or compare treatment to nontreatment student populations.
However, we did make deductions based on our written observations. They
will be used to guide us in focusing similar studies in the future. Here are
just a few ofthe lessons we learned from those observations:

l. Do not install unneeded software. In addition to purchasing key-
boards that time constraints did not allow us to use, we installed the
full, default set of software that came with the SoundBlaster Live
cards. Only near the end of the project as other teachers began to
report sporadic freezing and crashing problems did we realize that
this default set included nearly 350 MB of software that had nearly
filled the remaining space on the hard drive. We could have elimi-
nated about 300 MB of software with no loss to the project.
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2. Written materials should be simplified or eliminated. Students did
not have time or inclination to review several pages of text directions
as they worked the computers. Although we soon reduced the num-
ber of pages we gave to students at each session, even this may have
been too much. Templates helped with efficiency, but in the future
we will try other approaches-perhaps we will incorporate mediated
directions into the program itself.

3. Use a simpler music creation tool. The sequencer we used in this
project, Cakewalk Express, was included free with the SoundBlaster
card and was a high quality, versatile piece of software. However,
we began to notice early in the project that the majority of our teach-
ing time was being devoted to teaching children how to use the tool
and not how to create music. Cakewalk does allow the user to hide
unnecessary interface devices, and we used this feature. However,
in the future we may want to use a simpler tool with more intuitive
controls.

We made many more observations than can be included in this article.
A full report, including materials, images and music files, can be found on
the project Web site at http://music.utsa.edu/cmp.

Overall, at the IMR we feel that the Creative Music Project was suc-
cessful in its mission of pointing the way for similar studies. The observa-
tions we made obviously will help us avoid pitfalls and be more efficient in
the future. It also helped us develop some tentative answers to our initial
questions. It certainly seems feasible to set up a creative music making
environment without the huge monetary investment required only a few
years ago. Deducing from teacher reports, the students seemed to enjoy this
new type of music making. Furthermore, their music products seems to
indicate that any child can create original music that follows commonly
accepted structural guidelines of composition, and that they can do so within
the parameters of a normal public school curriculum. As to the quality of
their output, future studies will give us the opportunity to investigate this
factor in a more detailed manner. We might also find that quality of output
is purely a subjective judgment and not as important to a child's musical
education as the creative experience itself.

I What a surprise! We found that most children would rather manipulate the
computer program than listen to a university professor lecture on musical concepts
or read his carefully crafted directions on paper.
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Using Sibelius@ Notation Software
to Teach Music in Schools

Larry Marchese, Sibelius USA

When one first thinks of what to do with notation software, composing
and arranging music usually comes to mind. Indeed, that is the primary task
for notation software; however, the purpose of this paper was to demon-
strate how Sibelius@ can be an effective tool for the music educator in the
classroom. This presentation showed how Sibelius is very effective for the
student. The presenter first discussed why notation software is an excellent
tool in the classroom. Next, there was consideration of how Sibelius'at-
tributes make it especially effective at this task. Finally, the presenter showed
how Internet technology could be used by the music teacher and students.

Notation software provides an easy way to show music examples on a
computer screen. If an LCD projector is available, the music examples can
be projected to a large screen in the classroom. If a computer lab is avail-
able, the music examples can be placed on student computers.

Music is interactive, meaning it can be viewed, played, and heard. This
is the big advantage of notation software and fits music education perfectly.
What better way to teach than allow students to hear what they are studying,
writing, or analyzing? Notation software is an effective tool for creating
tests/exams, worksheets, flash cards, and so forth. MIDI files can be trans-
lated into music examples. Existing music can be scanned and made inter-
active. Music can be placed on the Internet.

How Does Sibelius Notation Software
Help Teachers Teach Music in the Classroom?

It is easy to learn. Why? Sibelius does not use a tool or modal system for
editing, note entry, copying, etc. (you do not have to select a specific tool or
mode). To edit, you simply click and move anything on the screen at any
time. You copy and paste notation like a word processor, and you may enter
music any way you like-and at any time.

Music can be entered using alphabetic input. Type A-G for pitches. In
addition (in Version 2), use the number keys (2 through 8) to create an
instant interval Use the arrow up and down keys to shift octaves up and
down, or to move diatonically up and down.

Keyboard shortcuts are easy to learn and remember: T : time signature,
K: key signature, S : slur, P : play, etc.

The keypad on the screen is shaped and organized like the number pad
on a computer keyboard. Pressing keys on the number pad corresponds to
the graphical keypad on the screen. Therefore, you do not have to learn a

number system or need a template.
Sibelius is organized in a very logical, intuitive way. Since it was de-

signed and written by musicians, for musicians, students and teachers alike
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usually can leam Sibelius very quickly. Because ofthis important fact, classroom
time does not have to be wasted learning a music tool. Obviously, class-
room time should be focused entirely on music.

Sibelius allows you to create music examples fast and efficiently. Mu-
sic can be input with a mouse, with the computer keyboard, and using a
MIDI device. With MIDI, music can be step input (one note at a time), or via
live playing. Our live entry system, Flexitime, is designed to input what you
meant to play. It tracks your tempo changes (intended or not), inserts articu-
lations (staccato, tenuto), and makes live entry one of the fastest ways to
enter music.

Music scanning technology has come along way and often surprises
people when they see what it can do. It has become agteat way to enter
music examples for analysis, teaching theory, etc. If it is printed music on
paper, you can scan it into Sibelius. Sibelius comes with a free copy of
Photoscore Lite,whichhas limitedfeatures, but is effective for smallerprojects.
Photoscore Pro is a full featured product that scans more marks, triplets,
and even text.

MIDI files (often found on the Internet) can be converted instantly into
music notation. Sibelius will save you time by automatically ordering the
instruments, inserting the necessary clefs, brackets, braces, signatures, tempo
marks, etc. All playback settings are automatic as well. Just open and press
play.

If you or your friends have music created in Finale o, Sibelius can read
those files as well. Since most music is currently created in Sibelius or
Finale, you can open and usejust about any notation file available.

Sibelius provides realistic playback. Any time you add articulations,
dynamics, tempo text, etc., Sibelius plays the music back that way. Students
can hear the impact of changes to the music. Computers typically play back
music very mechanically, however, Sibelius offers a variety of features to
make the music play much more musical. If you add a variety of marks to the
music and wish to save it as a MIDI file, Sibelius turns all marks into MIDI
information you'll hear if the file is played apart from Sibelius.

Teaching Tools is a classroom resource featuring a 200-page teacher
guide, 20 student skills booklets, and CD-ROM containing all the files. It is
a curriculum that describes how Sibelius is to be used in the classroom.
Each exercise contains an overview, objectives, and assessment, as well as

required skills and preparation, "How to do this with Sibelius," and exten-
sions. (The question marks on the graphic represent links from our Web site
describing each part of the material. The top pages are teacher completed
worksheets and student worksheets. The next pages show the curriculum/
exercise steps as mentioned above. The third booklet at the bottom is the
student skills guide.)
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MENC standards are met without you having to do anything extra. While
you are teaching music, computer skills are learned as well. Often this oc-
curs withoutyou realizing it. We have specifically designed Teaching Tools
so that using computers in the music classroom is as easy and transparent as

possible. All steps are given and presented in an organized manner. The
focus is entirely on teaching and learning music, not on the computer. Sibelius
and Teaching Tools are simply tools for the music educator and should
never be the focus in the classroom. The focus is music.

The Internet for Music Educators

In 1998, Sibelius introduced a new technology called Scorch@ that made
it possible for users to save anything created in Sibelius as a Web ready
page. It was simply a save-as function and no additional work was required,
making the task extremely easy, compared to the typical work required to
get something Internet ready. The music can be displayed and played back
on a Web browser, and even can be transposed. With the introduction of the
latest version of Scorch (which enables printing and the ability to save), the
applications for the classroom are even greater.

One classic example of using Internet technology can be found on our
Web site at http://www.sibelius.com/education/scales/. There you will find
Scorch@ pages containing scales that can be read, played, downloaded and
printed. They have been written in the treble and bass clefs, to be played on
any instrument The pages also include:

' Major scales in all keys
. Major arpeggios in all keys
. Minor scales in all keys (harmonic & melodic)
. Minor arpeggios in all keys
. Chromatic: can be hansposed to start on any note
. Modes: can be transposed to any key
. Dominant seventh arpeggios in all keys
. Diminished seventh arpeggios in all 3 diminished chords

Students can listen to the scales, practice with them, print them out, and
so forth. They are available 24hrs a day,7 days a week.

Here are some additional Internet applications:

The Vermont MIDI Project (http://www.vtmidi.org/), a network of over
60 schools across Vermont, is an online music mentoring project where
students in grades I throughl2 submit their music compositions for sharing
and critique by professional composers, teachers and other students. The
MIDI Project works with professional composers who give feedback to
student compositions online. Some composers are available as artists-in-
residence. Other composer/mentors also are music educators in schools,
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working with students on composition, as well as classroom music, or with
instrumental and choral performing groups.

Log on to their site for additional information and read about how suc-
cessful this project has become in teaching composing to students-and
how much fun the students are having in learning to compose music.

An application similar to the above scenario would involve students
placing compositions on the school Web site for their friends and parents to
see and hear. Since friends and parents may not read music, on the Web,
they can listen to it. This is highly motivational to kids, and is impressive to
parents (and the school board).

Teachers could create practice worksheets that are either generic scales
like the example above, or are more specifically related to region or state
tryouts; for example, all-region and all-state sight reading examples, warm
ups, and so forth.

What about practicing choral parts at home? In this case, you could
either e-mail Scorch files to students, or place them on the school Web site.
You could send them (or post) the following: just their part (so they can
listen and learn their part), all the parts minus their part (so they can practice
their part while listening to the others, or all the parts (so they can hear what
it's supposed to sound like (harmonically).

Here is what a "Scorch" file looks like on the Internet:

ffi ls;'ffiffifi,t

:. Cqh ft d.nEhke. hft 6hn€h Flrs.5:
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On the toolbar you may choose to turn pages, choose which sound de-
vice to use for playback, use the transport/playback controls and tempo
slider, click play button to play from the start, or click on the score to play
from that point, or stop. You may also change key, save the score to disk,
print, and obtain Scorch information and updates. Use Page Up and Page
Down and the up and down arrow keys to scroll up and down the score.

I trust this paper has been helpful to you as you consider the advantages
of notation software in the music classroom. We have looked at a variety of
music applications and seen how Sibelius, Teaching Tools, and Scorch are
powerful tools for teachers and students. Thank you for considering our
products.

66Yes, But Does It Help"? A Preliminary Report on a
Web Enhanced Large Lecture Music Appreciation Course

Dorothy Keyser and Katherine Norman
University of North Dakota

This presentation was a preliminary report of an ongoing investigation
of the effectiveness of Web enhanced interactive supplements to two sec-
tions of a music appreciation course taught in a large lecture format (N:
250). These supplements were delivered via Blackboard, a Web based course
management system developed by Blackboard Incorporated (http.'ll
www.blackboard.com).

Blackboard creates a course site framework with sections for announcements,
course information (syllabus, instructor information, etc.) and course docu-
ments (handouts, assignments, etc.). In addition, the program has a built-in
feature that makes it possible to create online tests and surveys that can be
automatically graded and the results recorded in an online grade book. The
software also incorporates several communication tools including a threaded
discussion list and a real-time chat program.

For the purposes of this investigation we concentrated on the following
capabilities of the system:

L Posting Grades

2. Dissemination of Information
o time sensitive announcements
o assignments
. course documents
o other course information
o instructor contact information
. course calendar
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3. Communication
o e-mail to instructor and graduate teaching assistant
o submission and response to assignments via the "digital drop box"
o threaded discussion list
o virhral office hours via the "virtual classroom"

The presentation had two parts: (a) documentation of how these system
capabilities were integrated into the course, and (b) a report of instructor
and student perceptions about their utility. The process ofdata collection
involved (a) student surveys at the beginning and end of the course, (b) mid-
semester small group focused interviews according to the Small Group In-
structional Diagnosis model (SGID), and (c) instructor interviews.

It is clear that students are receptive to Web based supplements to regu-
lar instruction, but it is also clear that there are several problematic issues
related to their implementation, their continued maintenance, and their use
by students. At this point, our results are preliminary rather than definitive.
Nevertheless, our current findings should be of interest to others who are
considering Web based enhancements to regular classroom instruction, in
particular, to those working in a large lecture class format. [n addition, the
SGID model might be of interest to other researchers who are working with
large groups.

Digital Video Editing - It's So Easy!
Eitaro Kawaguchi, Center for Music Research

Florida State University

Recent advancements in digital technology has made computer based
high quality video editing not only possible but also affordable. Conven-
tional video editing has been a tedious and expensive process, requiring
multiple video recorders. Often the results are disappointing. With the cur-
rent digital technology, one can easily edit and add titles and effects with
quality that was once possible only with professional equipment.

This paper discusses the basics of digital video editing and its merits,
what is necessary to get started, and some suggested applications.

What is Digital Video?

In a broad sense the term digital video refers to any video material that
is represented in digital format. Traditionally, video images were created,
stored, transmitted and viewed asing analog technology (standard analog
video format is called the NISC in the US-the format used in regular TV
broadcasting and VHS tape.) That is, the content of the video material (and
accompanying sound) is represented using the varying intensity of electri-
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cal voltage and current-the brighter the image, the higher the voltage, for
example. Digital video uses numbers to represent such information, and the
numbers are represented by a series ofelectronic pulses that can be trans-
mitted, processed and stored using computer technology.

Below are some examples of analog and digital video technologies and
equipment:

Analog: Conventional broadcasting (cable, aerial), TV sets, VCR's,
camcorders (VHS, S-VHS,8mm, Hi8), LaserDisc

Digital: Satellite broadcasting (DIRECTV, Dish Network etc.), DVD
players, DV and Digital8 camcorders

Note that many cable TV companies now offer digital broadcasting
through their cable connection, and older satellite broadcasting was in ana-
log format. Also, video (movie) clips one encounters on the Internet in the
formats such as RealVideo, QuickTime, Windows Media, and so forth, are
types of digital video. In the past the digital video seen on personal comput-
ers had poor quality compared to regular TV broadcasting. Today it is
possible to view and edit broadcast quality video on personal computers.

Why is Digital Video Editing Better?

Editing video using conventional analog technology involves copying
from one VCR to another and causes significant loss in quality unless one
usea professional grade equipment. Digital video editing enables intuitive
and extremely flexible manipulations and introduces little or no loss of
quality. You can preview the result of the edits before finalizing it, and
undo the edits that you do not like. The difference between analog and
digital video editing is analogous to the difference between using a type-
writer and word processing program.

What do I need to get started?

There are three key components for digital video editing:
1. Video source
2. Computer with FireWire (IEEE 1394) interface and cable
3. Video editing software

The video source is typically a camcorder or a VCR. A digital camcorder
(DV or Digital8) is ideal, but any standard video equipment (analog video
camcorder such as VHS and Hi8, VCR, LaserDisc, etc.) can be the video
source.

For effective editing, the computer should have a
power (PC: Pentium II or better, MAC: G3 or better),

Proceedings

decent processing
plenty of memory

83



(64M8 of RAM minimum), and a large hard disk drive-since digital video
materials usually contain a large amount of data (and the processing then
requires a lot of computational power).

If the video source is digital, then the computer just needs a FireWire
(IEEE 1394) interface. If the source is analog, then a device to convert
analog video into a digital format (and vice versa) is required.

A wide variety of video editing software is available. Note that FireWire
interface kits (you may have to purchase ne) often come with basic video
editing software; and also note that most digital camcorders also come with
such software. All current Macintosh models come with built-in FireWire
interfaces (cable must be purchased separately) and the iMovie video edit-
ing software.

The Process of Digital Video Editing

Capture. This is the process where video material is entered into the
computer. If the video source is a digital camcorder, then this process sim-
ply transfers the video data on the camcorder tape to the computer via the
FireWire cable. The video data is stored on hard disk in DV format. [t
requires about 200 MB of disk space for one min of video.

Edit. Once the video material is captured, you can edit it using video
editing software. Most editing software will not actually modify the cap-
tured video, but create (render) a new file, reflecting the changes you make.
Below are the kinds of edits that can be made.

r' Change the sequence ofscenes
/ Cut out unwanted parts
r' Insert scenes from other video materials that were captured

separately
{ Add extra audio materials such as narration and background

music
r' Insert still photos
r' Alter the playback speed

*Create fade-in/out, scene dissolve (cross fade)
* Superimpose (overlay) text
{.Apply filters-change hue, brightness, sharpness etc

*Apply various other effects

The { in the list above indicates that there is no degradation ofthe video
quality. On the other hand, the edits with * require recalculation (render-
fng) of the images, and may cause slight quality degradation (although not
noticeable in most cases). What you can do depends on the editing software
you use, but even with the most basic software you can perform most of the
above.
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Export. This is the process in which yotJinalize the edited video. The
quality of the original video is retained when you record the result back to
the digital camcorder's tape (DV format), except for the minute degrada-
tion caused by the rendering of edited portion mentioned above. Other op-
tions are to record the video on a regular analog video tape (i.e., VHS-
many digital camcorders function as a converter of DV format to analog
NTSC), CD/DVD discs, or convert to streaming video format (QuickTime,
RealVideo, Windows Media) for viewing via the Internet.

Although there are many inexpensive software products available to
make DVD discs, making them is still rather expensive due to the cost of the
hardware and media. If you own a CD writer (CD-R or CD-RW), however,
it is possible to create CDs in the format called the Video CD (VCD) or
Super-VCD (SVCD) that can be played on many stand alone DVD players
and on computers. Although these formats allow shorter content lengths
(80 min on VCD, 35 min on SVCD), and quality is not as good as DVD
(because CD has much less capacity than DVD), these are viable options for
archiving and distributing the finished video until making DVD discs be-
comes more affordable.

Applications

The flexibility of digital video editing makes video you shoot more
viewable and interesting. Besides recording the edited video on conven-
tional media (i.e., VHS tape) you can distribute the video on CD-R/RW
discs. These discs can be copied more easily, quickly, and inexpensively.
The VCD/SVCD format mentioned in the previous section supports a menu
system similar to that of DVD discs, which makes easier navigation of the
contents possible.

Viewing digitalvideo on a computerwith some commercially available
video player software allows bookmarking. Such a feature may be helpful
in analyzing video footage, such as activities recorded in the classroom.

Ifyou have access to multiple video cameras, shooting multi-angle shots

of a single object (a musical instrument being played, etc.) and combining
them is easy in digital video editing. Such video can become an effective
observation/teaching tool.

General Information on Digital Video Editing

Getting Startedwith Digital l/ideo Editing
http ://userwww. sfsu. edu/-church/dvsite/start.htrnl
Beginner's guide to Digilal Yideo Production
http ://www. dYmoviemaking. com/
What do I Need to Set up a Nonlinear Yideo Editing Systern?

http ://desktopvideo. miningco. com/compute/desktopvideo/library/weekly
aaO52599.hfit
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o Global DVC Digital Videographers Club
http //www. global-dvc.org/

o DVFAQ
h@ : //www. adamwilt. com/Dv. hhnl#FAQ

FireWire (IEEE 1394) interface kits and related products

c ADS Pyro DV Series (PCA4AC)
http ://www. adstech. com/products/intro/products. asp

http ://www. adstech. com/products/PYROPlatinumDV(Cardbus)/intro/
API52 I info.asp?pid:APl-65 I W
(for notebooks)

o Adaptec FireConnect 4300 (PCIMAC\
http : //www. adaptec. com/worldwide/producV
proddetail.html?prodkeyAFW-
43 00 &caFYo2f Technology%2 fFireWire - I 39 4%o2fF ir eW ir e-

l3g4iAdapters
t Dazzle DV Editor (PC)

http : //w\ /w. d azzle.coml pr oducts/vided.htnl
http: / lwww .dazzle.com/products/vidednote.htnl (for notebooks)

o Dazzle Hollywood DT-Bridge (analog-to-DV converter) (PCA4AC)
h@ ://www. d azzle. com/ pr oducts/hw_bridge.htrnl

c ATI DVWonder (PC)
http ://www. ati. com/products/pc/dvwonder/index.htnl

o Belkin FireWire cables (mostFireWire kits come with cable) (PCA4AC)
http: I / eatalo g.belkin. com/
IWCa6ectionView.process?IWAction:Inad&Mucbant-ld=&Section_Id= 1 976

Apple Products

o Current Macitosh models
http://www.apple.com/hardware/

o iMovie Yideo Editor (bundled with current Mac models)
http ://www. apple. com/imovie/

o iMovie related article at ZDNet
http: I lwww.zdnet.com/zdhelp/stories/m ain/ 0,5 59 4,27 8 1 997,00.html

Video Editor Software

c FinalCutPro(MAC)
http : //www. apple. com/fi nalcutpro/

o Adobe Prernire (MAC/PC)
http ://www. adobe. com/store/products/premiere.htrnl

o Media 100Inc. CineStrearn (MAC/PC)
http ://yopu. com/cinestream/

o Ulead MediaStudio Pro (PC)
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FFr"

h@://www.ulead.com/msp/runme.htn
o UeadYideoStudioQC'1

ht$://www.ulead.corn/vs/runme.htm
o DazzleMainActor(PC)

http: I lwww .dazzle.com/productilm_actor.htnl

Dilital Camcorders

o Son!-DY/DigitalS
http ://www. sonystyle.corn/digitalimasng/minidv.htn
h@ l/www. sonystyle. com/digitalimaging/digitalS.hun

o Panasonic
http ://www.panasonic.com/consumer_electronics/camcorder/default. asp

o Canon
http://www.canondv.com/

o JYC
http://www jvc.corn/product j sp?productld=PRD 1 203 000
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